
 
 
 

Word 2003: Forms 
Learning guide 
 
 
 Why use Word forms? 

If you've ever worked on a project that involves collecting data 
from a group of people, you've probably designed a form using 
Word.  Although a Word form is easier to distribute and use than a 
paper form, users will often print the form and send it back with 
handwritten information that may not be easy for you to read.  In 
other cases, users may change the layout of your form to 
accommodate the information that they enter.   
 
Word 2003 helps eliminate these problems by allowing you to add 
form elements – text boxes, checkboxes, and drop-down menus – 
to the forms you’ve already designed so that they can be easily 
used without the need for any format changes.  Once you’ve 
inserted these elements, your users can enter their data (without 
disturbing the form’s layout), save the form, and return it to you in 
hard copy or via email.  The result is a form that’s easy for 
everyone to use and highly readable for you. 
 
 
 
Getting started 
After you’ve designed your form in Word, you can insert form 
elements that will allow the users of your form to enter their 
information. 
 
Displaying the forms toolbar 
• From the View menu, select the Toolbars submenu. 
• From the Toolbars submenu, select Forms.  
• The Forms toolbar will appear as a floating window near the 

top of your document. 
 

` 
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Adding form elements to your document 
Once the Forms toolbar is visible, you can add form elements to 
your document.  Word allows you to insert three kinds of form 
fields: 
 
The form fields …  Allow users … 
Text boxes To enter any kind of text, including 

contact and descriptive information. 
Check boxes To answer a question by selecting one 

or more options from a set of responses. 
Also, to supply a yes or no answer to a 
question on your form. 

Drop-down menus To answer a question by selecting one 
option from a set of responses.  

 
 
 
Adding a Text Field to your Document 
Creating a text field 
• Click to place the insertion point at the location in your 

document where you’d like to insert your text field. 
• On the Forms toolbar, click on the Text Form Field button. 
 

 
 

• Word will insert a text box to the left of your insertion point. 
 

 
 
 

Tips:  
• If your form currently provides underlined areas for users to 

enter their responses, be sure to remove all of the underlining 
from each area before inserting your form fields. 

• You can format the contents of a text field just like you can 
format any other text in a Word document: 

o Drag the cursor across the field to select it. 
o Right click on the field. 
o From the pop-up menu that appears, choose the Font, 

Paragraph, or Bullets and Numbering menu item to 
begin formatting the form field. 

o Any formatting you select will be applied to text entered 
by your users in that field. 

Text field 
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• To more easily identify your text field within your form, shade 
it in gray by clicking on the Form Field Shading button on the 
Forms toolbar. 

 

 
 
 
Customizing a text field 
Once you’ve inserted a text form field, you can specify several 
options for the field. 
• Double-click on a text field you inserted. 
• The Text Form Field Options window will appear.  
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• To specify the type of text that users will enter in this field: 
o Click on the down-facing arrow next to the box labeled 

Type. 
o From the drop-down menu, choose the type of text that 

is appropriate for the response to your question. 
 

 
 

For your users to insert…. Choose…. 
Names; job titles; other text Regular text 
Numbers; currency values Number 
Dates Date 

 
To automatically insert…. Choose…. 
The date the form is completed Current date 
The time the form is completed Current time 
A calculated value Calculation 

 
• To specify a default value for your text field: 

o Click in the box labeled Default text and type the 
default value you wish to use.  

• To specify the maximum number of characters that can be 
entered in your text field: 

o Click in the box labeled Maximum Length and type 
the maximum value.  

• To specify the format for the contents of your text field: 
o Click on the down-facing arrow next to the box labeled 

Text Format.  If you have chosen the Number or Date 
format, this box may be labeled as Number Format or 
Date Format. 

• Click on the button labeled Ok to apply the options you 
selected to your text field. 

 
 
Tip: When you first create your text field, its Maximum Length is 
Unlimited.  However, when form users enter a great deal of text, 
Word may restructure the layout of your form to accommodate the 
text they enter.  To prevent your form layout from changing, limit 
the number of characters that can be entered in your text field. 
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Adding a Check Box to your Document 
Creating a check box 
• Click to place the insertion point at the location in your 

document where you wish to insert your check box. 
• On the Forms toolbar, click on the Check Box Form Field 

button. 
 

 
 
• Word will insert a check box to the left of your insertion point. 
 
 
Customizing a check box 
• Double-click on a check box you inserted. 
• The Check Box Form Field Options window will appear.  
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Specifying the size of your Box 
When you create your checkbox, Word will assign an automatic 
size for the box based upon the size of the text in your form. To 
specify the size of your box: 
• On the Check Box Form Field Options window, locate the 

Check Box Size area.  
• Click on the option button labeled Exactly. 
• In the box to the right of the option button, enter the size (in 

points) for your checkbox. 
 

 
 
 
To place a check mark by Default 
In many cases, you may want to specify that your new checkbox 
will be checked by default if the most common answer to its 
question is Yes.  To place a checkmark in the box by default:  
• On the Check Box From Files Options window, locate the 

Default Value area. 
• Click on the option button labeled Checked. 
 

 
 

• Click on the button labeled Ok to apply the options you 
selected to your check box. 

 
 
Adding a Drop-Down Menu 
Creating a drop-down menu 
• Click to place the insertion point at the location in your 

document where you wish to insert your new menu. 
• On the Forms toolbar, click on the Drop-Down Form Field 

button. 
 

 
 

• Word will insert a drop-down menu to the left of your insertion 
point. 
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Adding items to a drop-down menu 
Once you’ve created a drop-down menu, you can add items to the 
menu and organize them so that they are listed in the order that 
will be easiest to use. 
• Double-click on the drop-down menu you inserted. 
• The Drop-Down Form Field Options window will appear.  
 

 
 

• Click in the box labeled Drop-down item and type the first 
item to be displayed in your menu. 

• Click on the button labeled Add to move the menu item into 
the box labeled Items in drop-down list. 
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• In the box labeled Drop-down item, type the second item to be 
displayed in your menu. 

• Click on the button labeled Add to move the second menu item 
into the box labeled Items in drop-down list. 

• Repeat these steps to add additional menu items. 
 

 
 
 
Reordering items in a drop-down menu 
Unless you reorder the items in your menu, form users will see 
them in the order you added them to the menu.  However, Word 
makes it easy to reorder your menu items. 
 
To display a menu item in a position closer to the top of the menu: 
• In the box labeled Items in drop-down list, click to select the 

menu item whose position you wish to change. 
• On the right side of the Options window, click on the Move 

button labeled with the up-facing arrow to move the item one 
position higher in the menu. 

• Click on the Move button labeled with the up-facing arrow, as 
needed, to move the item higher in the menu. 
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To display an item in a position closer to the bottom of the menu: 
• In the box labeled Items in drop-down list, click to select the 

menu item whose position you wish to change. 
• On the right side of the Options window, click on the Move 

button labeled with the down-facing arrow to move the item 
one position lower in the menu. 

• Click on the Move button labeled with the down-facing arrow, 
as needed, to move the item lower in the menu. 

• Click on the button labeled Ok to finalize the order your drop 
down menu. 

 
Tip: When a user opens your form document, each drop-down 
menu will display the first item in its drop-down list.  This may be 
confusing for your users. To avoid this problem, add the text 
“Choose one…” as the first item in each menu. 
 
 
Making your form easy to use 
Once you’ve added form elements to your Word document, you 
will need to add instructions to your form so that its users can 
easily enter information according to your guidelines.   
 
Adding instructions to the design of your form 
The simplest way to add instructions to your form is to include the 
text of these instructions in the form’s design.  You can draft 
instructions, and include them: 
• At the top of the form, just above the area where your users 

will enter their information.   
• As part of each section of the form 
 
Tip: Be sure to write instructions that are clear.  Also, consider 
providing the users of your form with a step by step process for 
completing the form correctly. 
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Adding instructions to a form element 
In addition to clear instructions in the layout of your form, you can 
also add short instructions to each form element.  These 
instructions will pop up in a separate window when a form user 
presses the F1 key on his or her keyboard after clicking on a form 
element. To add instructions to a form element: 
• Double-click on the form field you wish to add instructions to. 
• The Options window will appear. 
• In the lower left corner of the Options window, click on the 

button labeled Add Help Text. 
 

 
 
 
• In the Form Field Help Text window that appears, click on 

the tab labeled Help Key (F1). 
• Click on the option button labeled Type your own. 
• In the box beneath the option button labeled Type your own, 

type the text of your instructions. 
• Click on the button labeled Ok to save the instructions. 
 

 
 

• Click on the button labeled Ok to close the Options window. 
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Testing your form 
Once you have added form elements to your form, you should test 
the form to make sure that it works the way you intended it to 
work.   
 
Protecting your form 
Before testing your form, you will want to temporarily protect your 
form to prevent changes to any part of the form except the form 
elements so that you can use the form the way your users will. To 
protect your form: 
• From the Forms toolbar, click on the button labeled Protect 

Form.  
  

 
 
 
Entering your information 
• Enter information in the form elements you created.  Make sure 

that you enter the most common responses in each field, so that 
you can preview the experience that your users will have. 

• To remove all information from your form fields after each 
test: 

o From the Forms toolbar, click on the button labeled 
Reset Form Fields. 

 

 
 
 
Un-protecting your document 
When you have finished your testing, you will want to remove the 
temporary protection. To remove the temporary protection: 
• Click on the button labeled Protect Form.  
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Protecting your form 
Once you’ve tested your form, you will need to protect the form so 
that your users will not be able to change its layout. 
• From the Tools menu, select Protect Document. 
 

 
 
• From the Protect Document window that appears, click to 

place a check mark in the box labeled Allow only this type of 
editing in the document. 

• Click on the down facing arrow below the box labeled Allow 
only this type of editing in the document and select Filling in 
Forms. 

• Click on the button labeled Yes, Start Enforcing Protection.  
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• The Start Enforcing Protection window will appear. 
• Click on the option button labeled Password.  
• Click in the box labeled Enter new password and type the 

password you wish to use to prevent your users from removing 
the form’s protection.  

• In the box labeled Reenter password to confirm, retype the 
password you wish to use. 

• Click on the button labeled Ok to start enforcing the 
protection. 

 

 
 
 
Tips: Setting passwords 
• Setting a password prevents users of your form from removing 

its protection and changing its design.   
• Choose a password that will be easy for you to remember, but 

hard for someone outside your department to guess.  For 
example, don’t use the name of your department as the 
password!   

• Set a single password for all of your protected Word forms, or 
one password for each group of related forms.  This practice 
will keep your forms secure but will make it easier for you to 
remember the passwords you set. 
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Removing protection from your form 
If you need to revise your form after you have protected it, you 
will need to first remove the form’s protection before you can 
make any changes. To remove protection from your form: 
• From the Tools menu, select Unprotect Document. 
• The Unprotect Document window will appear. 
• Click in the box labeled Password and type the password for 

your form.  
• Click on the button labeled Ok to remove protection from your 

form. 
 

 
 
 
Tip: Test your form with actual form users 
Once you distribute your form, there are often logistical factors 
that make it hard to release a revised version of the form.  Before 
you distribute your form, ask some actual users of the form to try it  
out and provide you with feedback.  Those additional comments 
will probably help you make the form much easier to use. 
 
 
 
Distributing your form 
Once you have finished your form and protected it, you are ready 
to distribute your form to the people who will use it.  Here are 
some good ways to make your form widely available: 
• Send an announcement via email to the people who will use the 

new form.  Offer to email the new form to anyone who 
requests it. 

• Save the form as a Word template on your department’s 
network drive (or Q drive) so you’re your colleagues can open 
it, make a copy, and fill out the form.  Be sure to tell people 
where they should save completed versions of the form. 

• Post the form on your website so that users can download it.  
On the download page, be sure to specify the email address to 
which users can send the completed form. 
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